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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use proper power cord. Use only the power cord specified for this product and certified for the country
of use.

Use proper voltage setting. Before applying power, ensure that the line selector is in the proper position for
the source being used.

Connect and disconnect properly. Do not connect or disconnect probes or test leads while they are
connected to a voltage source.

Ground the product. This product is indirectly grounded through the grounding conductor of the mainframe
power cord. To avoid electric shock, the grounding conductor must be connected to earth ground. Before
making connections to the input or output terminals of the product, ensure that the product is properly
grounded.

Observe all terminal ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Do not apply a potential to any terminal, including the common terminal, that exceeds the maximum
rating of that terminal.

Power disconnect. The power cord disconnects the product from the power source. Do not block the power
cord; it must remain accessible to the user at all times.

Do not operate without covers. Do not operate this product with covers or panels removed.

Do not operate with suspected failures. If you suspect that there is damage to this product, have it inspected
by qualified service personnel.

Avoid exposed circuitry. Do not touch exposed connections and components when power is present.

Use proper AC adapter. Use only the AC adapter specified for this product.
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Do not operate in wet/damp conditions.

Do not operate in an explosive atmosphere.

Keep product surfaces clean and dry.

Terms in This Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product
or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:
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Using Online Help
Select Help from the menu to open the help file. You can also find an electronic copy of the help file
in the Documents directory.

Tables of Contents (TOC) tab—Organizes the Help into book-like sections. Select a book icon to open
a section; select any of the topics listed under the book.

Index tab— Enables you to scroll a list of alphabetical keywords. Select the topic of interest to bring
up the appropriate help page.

Search tab— Allows a text-based search.

Follow these steps:

1. Type the word or phrase you want to find in the search box. If the word or phrase is not found, try the
Index tab.

2. Choose a topic in the lower box, and then select the Display button.

General Help Functions
Select the Print button from the Help topics menu bar to print a topic.

To return to the previous window, select the Back button.

Use hyperlinks to jump from one topic to another.

If the back button is grayed out or a jump is not available, choose the Help Topics button to return to
the originating help folder.

Conventions
The online help uses the following conventions:

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

Table 1: Icon descriptions
Icon Meaning

This icon identifies important information.
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Table 1: Icon descriptions (cont.)

Icon Meaning
This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the
application more efficiently.

xxx

Documentation
The following table lists the documentation that is available for the product and shows where you can
find it.

Table 2: Product documentation
Item Purpose Location
Online Help In-depth operation and UI help.
User Manual (adapted from the
online help)

In-depth operation and UI help.

Quick Start User Manual Provides operation and application
information.

xxx
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Technical Support
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General Information
All instrument model numbers.

Hardware options, if any.

Probes used.

Your name, company, mailing address, phone number, and FAX number.

Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application Specific Information
Software version number.

Description of the problem such that technical support can duplicate the problem.

If possible, save the setup files for all the instruments used and the application.

If possible, save the application setup files, log.xml and status messages text file.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Forward the information to technical support using one of these methods:

E-mail: techsupport@tektronix.com

FAX: (503) 627-5695
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Getting Started Test Setup

Test Setup

Test Fixtures
The Tektronix fixtures used are:

TF-HEAC-TPA-KIT consisting of:

TF-HEAC-TPA-MAIN, Tektronix part number 863-0482-00

TF-HEAC-TPA-AP, Tektronix part number 863-0478-00

TF-HEAC-TPA-CP, Tektronix part number 863-0479-00

2 each TF-HEAC-TDR-AR, Tektronix part number 863-0480-00

2 each TF-HEAC-TDR-CR, Tektronix part number 863-0481-00

TF-HDMI-TPA-CE (EDID board, Tektronix part number 878-0475-00), consisting of:

EDID fixture PCBA

EEPROM with HDMI 1.4 software

Ribbon cable

TF-HDMID-TPA-KIT (required for HEAC testing of Type D devices) consisting of:

Plug assembly

2 each Receptacle cable assembly

Oscilloscopes
The recommended oscilloscopes are:

Tektronix DPO7000 Series Digital Oscilloscope

Tektronix DPO70000 Series, DPO70000B Series, DSA70000 Series, and DSA70000B Series Digital
Oscilloscope

Tektronix MSO70000 Series Mixed Signal Oscilloscope

Probes
The recommended differential probes are:

Tektronix P6247, P6248, P6330, or P7330 for Tektronix DPO70000 Series, DPO70000B Series,
DSA70000 Series, and DSA70000B Series Digital Oscilloscopes

Tektronix P6247, P6248, P6330, or P7330 for Tektronix MSO70000 Series Mixed Signal Oscilloscopes

Tektronix P6330, TDP1000, TDP1500, or TDP3500 for Tektronix DPO7000 Series Digital
Oscilloscopes
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The recommended single-ended probes are:

Tektronix P6243 or P6245 for Tektronix DPO70000 Series, DPO70000B Series, DSA70000 Series,
and DSA70000B Series Digital Oscilloscopes

Tektronix P6243 or P6245 for Tektronix MSO70000 Series Mixed Signal Oscilloscopes

Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series Digital Oscilloscopes
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Arbitrary Waveform Generators
The recommended arbitrary waveform generators are:

Tektronix AWG5000 Series and AWG5000B Series

Tektronix AWG7000 Series and AWG7000B Series
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Minimum System Requirements
The minimum system requirements for a PC to run the application are as follows:

Table 3: System requirements
Processor Pentium 4/M or equivalent processor.
Operating System Windows XP Service Pack 2.
Memory 512 MB of memory.
Hard Disk Approximately 2 GB of available hard-disk space for the recommended

installation, which includes full TekExpress installation and distributed
components.

Drive DVD drive
Display Super VGA resolution or higher video adapter (800x600 minimum video

resolution for small fonts or 1024x768 minimum video resolution for large fonts).
The application is best viewed at 96 dpi display settings 1.

Software Microsoft Excel 2002 or above.

Microsoft Internet Explorer 6.0 SP1 or later.

Adobe Reader 6.0 or equivalent software for viewing portable document
format (PDF) files.

Other Devices Microsoft compatible mouse or compatible pointing device.

Two USB ports (One USB port minimum).

PCI-GPIB or equivalent interface for instrument connectivity 2.
xxx

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended
to connect a secondary monitor and this has to be enabled before launching the application.

2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port cannot be used by TekExpress for communicating with oscilloscope
applications.
If external devices like USB-GPIB or equivalent are used for instrument connectivity, ensure that the Talker Listener utility is enabled in the
DPO/DSA oscilloscope’s GPIB menu.
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Application Directories and Usage
The application directory and associated files are organized as follows:

The following table lists the default directory names and their usage:

Table 4: Default directory names and their usage
Directory names Usage
InstallDir\TekExpress\TekExpress HEAC Contains the application and associated files.
TekExpress HEAC\ACP Includes instrument and application specific

interface libraries of TekExpress.

TekExpress HEAC\Bin Includes instrument and application specific
interface libraries of TekExpress.

TekExpress HEAC\Compliance Suites Has compliance specific sequence files. The folders
under this directory represent the devices to be
tested.

TekExpress HEAC\Compliance Suites\HEAC Includes the “HEAC-Receiver” and
“HEAC-Transmitter” folders.
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Table 4: Default directory names and their usage (cont.)

Directory names Usage
TekExpress HEAC\Compliance Suites\HEAC\HEAC-

Receiver
Includes the “CommonMode-Rx“, “Differential-Rx”,
and “SingleMode-Rx” folders.

TekExpress HEAC\Compliance Suites\HEAC\HEAC-

Transmitter
Includes the “CommonMode-Tx“, “Differential-Tx”,
and “SingleMode-Tx” folders.

TekExpress HEAC\Data Manager

TekExpress HEAC\Data Storage

Includes the result management specific libraries of
TekExpress are present in these folders.

TekExpress HEAC\Documents Includes the technical documentation for the
application.

TekExpress HEAC\ICP Includes instrument and application specific
interface libraries of TekExpress.

TekExpress HEAC\Lib Includes the miscellaneous libraries of TekExpress
TekExpress HEAC\Report Generator Includes the result management specific libraries of

TekExpress are present in these folders.
TekExpress HEAC\SCP Includes instrument and application specific

interface libraries of TekExpress.
TekExpress HEAC\Tools Includes the miscellaneous libraries of TekExpress.
xxx

NOTE. Ensure that you maintain the directory structure and do not accidentally modify it.

File Name Extensions
The software uses the following file name extensions:

File name extension Description
.TekX The session file will be saved in this format.
.seq The test sequence file.
.xml The encrypted XML file that contains the test specific configuration information. The

log file extension is also xml.
.mht The report file is saved in this format.
xxx
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How To Activate the License
You can directly activate the license from the menu. Select Help > Activate License. Enter the License
Key in the License Info dialog box.

You can also activate the license in another manner. Follow the steps below to activate the license:

1. Click Help > About to view the license information.

2. Click the View Version Details link to check the version numbers of the installed test suites.

3. Click the View End-User License Agreement link to open the following Tektronix Software License
Agreement window. Click Print to print the License Agreement.

TekExpress HEAC Automated Solution 11



Getting Started Before You Click Run

4. Click License Info to view the available software options. This window shows the license key and the
various options with their status (active or inactive) with the current license key.

Before You Click Run
After you first launch TekExpress, it creates the following folders on your computer:

\My Documents\My TekExpress

NOTE. Ensure that the “My TekExpress” folder has read and write access. Ensure that you maintain the
directory structure and do not accidentally modify it.

NOTE. If a user with a different Windows login ID launches TekExpress, a new My TekExpress folder is
created under that user’s My Documents folder.

\My Documents\My TekExpress\HEAC

\My Documents\My TekExpress\HEAC\Untitled Session. Every time the HEAC.exe is
launched an Untitled Session folder is created under HEAC folder. The Untitled Session

folder is deleted when you exit TekExpress.

CAUTION. Each session has multiple files associated with it. Do not modify any of the session files and/or
folders as this may result in loss of data or corrupted session files.
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The My TekExpress folder is created as a shared folder with share name as <domain><user
ID> My TekExpress (or if the PC is not connected to domain then share name is <Computer
name><user ID> My TekExpress).

The above shared folder is mapped as X: (X drive) on to the PC where TekExpress is running.

NOTE. Map the X: drive only when TekExpress is not running on an oscilloscope. Map the X: drive
between the oscilloscope and personal computer or the laptop computer on which TekExpress is running.

NOTE. If X drive is mapped to any other shared folder, TekExpress will display a warning message window
asking to disconnect the X: drive manually.

Do the following before you click Run:

NOTE. Ensure that the network connectivity is enabled on the PC running the TekExpress.

1. Map (see page 13) the shared My TekExpress folder as X: (X drive) on all the instruments used
in test setup running Microsoft Windows Operating System. This share folder is used to save the
waveform files or any other file transfer operations.

2. Right click the My TekExpress folder and open the Properties dialog box. Select General tab and
then Advanced. In the Advanced Attributes window, ensure that the option Encrypt contents to
secure data is NOT selected. Click here (see page 14) to view the picture.

3. Ensure that all the required instruments are properly warmed up, Signal Path Compensation (SPC) (see
page 14) is performed, followed by cable deskew.

Mapping My TekExpress folder
To map the My TekExpress folder on the instruments, follow the steps below:

1. Open Windows Explorer.

2. From the Windows Explorer menu, select Tools > Map Network drive.

3. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer).

4. In the Folder field, enter remote My TekExpress folder path (for example, \\192.158.97.65\
John’s My TekExpress)

5. You can determine the IP address of the PC where “My TekExpress” folder exists by doing
the following:

Select Start > Run menu on the PC where My TekExpress folder exists.

Enter cmd and click Enter.

At command prompt, type ipconfig.
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You can find SPC by following the steps below:

1. On the oscilloscope main menu, click Utilities menu.

2. Click Instrument Calibration option.
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Application Overview
TekExpress is the Tektronix Compliance Test Automation Framework, developed to support current and
future test automation needs of customers. Developed using National Instruments’ TestStand, TekExpress
leverages on the capabilities of the Microsoft .NET framework.

TekExpress HDMI Ethernet Audio Return Channel (HEAC) addresses the testing and compliance needs
of HEAC and HEAC /CTS1.4, and provides the following features:

Reliable testing

Conformance to HDMI 1.4 (HEAC) standards and test specifications CTS 1.4 ensures reliable
results

Accurate Transmitter (Tx), Receiver (Rx), and violation testing ensures reliable tests

Sophisticated measurement techniques eliminate errors in jitter measurements

Closed loop measurements eliminate non-linearities of test setup enables precise testing

Significantly reduced test times for Sink and Audio tests

Optimal setups ensure accurate results

Fast testing

Remote control of signal sources automates Source and Sink tests and reduces test times

One-button selection of multiple tests ensures faster testing

Automatic mask fit, measurements, and Pass/Fail notification delivers quick results

Test margins and statistical information aid analysis to help find answers quickly

One-button csv-format summary and MHT report saves time

Complete testing

Wide range of tests for Source and Sink devices enables complete validation

Complete compliance solution with a test fixture and signal sources
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Starting the Application
To start the application, do one of the following:

Click Start > Programs > Tektronix > TekExpress > TekExpress HEAC. Other applications
follow similar pattern.

Double click the icon on the desktop.

If you have previously saved a session, double-click the session file stored under My
TekExpress\HEAC.

When the application is launched it displays the splash screen providing launch information.

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the
previously unsaved session.

Resizing the Application Window

To minimize the application, click on the application title bar. To restore the application to its

previous size, select in the Windows task bar.

To maximize the application, click . To restore it to previous size, click on the application
title bar.
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Exiting the Application
To exit the application, do one of the following:

Click File > Exit.

Click on the application title bar.

Global Controls
The menus and controls that appear outside the individual tabs are called “Global Controls”. These are
used to specify the devices to be tested.

Table 5: Controls and Functions
Control name Function
DUT The device ID is specified at the global level and the

information is stored in the default location for all data
files. This field cannot be empty and does not allow these
special characters (.,..,...,\,/:?”<>|*). The maximum length
of characters allowed is 32.
This indicates whether your PC has enough memory to run
and test a measurement.

You will be able to run, pause, resume and stop the tests.

xxx
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File Menu
Click File on the application menu bar.

The File menu has the following selections:

Menu Function
New Session Starts a default session of TekExpress.
Open Session Opens a saved session.
Save Session Saves the session.
Save Session As Saves a session in a different name.
Recently Recalled Setup Lists recent setups.
Print Preview Report Previews the report before printing.
Print Report Opens the Windows “Print” dialog box.
Exit Closes the application.
xxx

View Menu
Click View on the application menu bar.

The View menu has the following selection:

Menu Function
Log Opens the log (log.xml) file in the default viewer.
xxx
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Tools Menu
Click Tools on the application menu bar.

The Tools menu has the following selection:

Menu Function
Instrument Bench Opens a dialog box showing the list of instruments attached to the test setup.
E-mail Settings Opens a dialog box showing the e-mail setting details.
xxx

Tools > Instrument Bench
The Instrument Bench window shows the list of VISA and Non-VISA resources found on different
interfaces/connections. It serves two purposes at the launch of TekExpress:

Discovers the connected instruments.

Confirms the instrument connection setup.

When you click Tools > Instrument Bench, the following dialog box is displayed:
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Search Criteria: The various connections on which you can search. Non-VISA Resources are the
instruments that cannot be searched using TekVISA.

Retrieved Instruments: Displays the count and details of instruments that were discovered.

Last Updated: Displays the time when the last time search was performed.

TekVISA Refresh Timeout (Seconds): This time out specifies the maximum time that TekExpress
can wait for TekVISA update.

NOTE. TekExpress uses TekVISA for instrument search. Ensure that TekVISA is running on your system
before you refresh the instrument bench window.

Table 6: Retrieved resources properties in the Instrument Bench window
Item Description
Connection Shows the type of connection with the instrument.
Resource Shows the name of the resource.
Serial Number Shows the serial number of the resource.
Options Shows the options available on the instrument. 1

Resource Address Shows IP Address/Port number of the resource.
xxx

1 The option column displays the options that fit in the field. To view complete options on the instrument, move the mouse cursor over the option.

Table 7: Button controls on Instrument Bench dialog box
Button Function
Refresh The application searches on the selected connection for resources. While

searching resources it shows the Instrument Bench discovery window. The
Discovery window shows the connection currently being scanned and the
percentage of task completed.

Close Closes the dialog box.
xxx

Tools > E-mail Settings
Use the E-mail Settings utility to configure and set the e-mail options. The following fields are mandatory
for receiving e-mail notification from TekExpress:

Recipient E-mail Addresses. For example, User@domain.com.

Sender’s Address.

SMTP Server address of the Mail server configured at the client location.
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NOTE. The application will not send an e-mail notification if any of these fields are left blank or you do
not save the settings.

Select the option E-mail Test Results When Complete or on Error to receive the e-mail. The attachment
list depends on what you selected while configuring the e-mail setup.

NOTE. The Analysis Screenshot option is not yet functional.
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Help Menu
Click Help on the application menu bar.

The Help menu has the following selections:

Selection Description or Function
TekExpress Help Displays TekExpress Help (F1).
About TekExpress (see page 11) Displays application details such as software name, version

number, and copyright.
Activate License Displays a dialog box to enter the license key.
xxx
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Set Up the Switches on the HEAC-TPA-MAIN Fixture
The following diagram shows the fixture configuration switches on the HEAC-TPA-MAIN fixture.

The following table shows the switch settings to configure on the HEAC-TPA-MAIN fixture.

Table 8: HEAC-TPA-MAIN switch setup

Test ID Description DUT
+5 V
from S1 S2 S3 S4 S7

Source J6, J8 Right Right Right Left Right5-1 Differential Mode
Operating DC Sink J8 Left Left Left Right Left

Source J6 Right Right Right Right Right5-2 to 5-5 Differential Mode
Transmitter Sink J8 Left Left Left Right Left

5-6 to 5-10 Common Mode
Transmitter

Sink J8 Left Left Left Right Left

5-11 to 5-15 Single Mode
Transmitter

Sink J8 Left Left Left Right Left

Source J6 Right Right Right Right Right5-16 Differential Mode
Receiver Sink J8 Left Left Left Right Left
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Table 8: HEAC-TPA-MAIN switch setup (cont.)

Test ID Description DUT
+5 V
from S1 S2 S3 S4 S7

5-17 Common Mode
Receiver

Source J6 Right Right Right Right Right

5-18 Single Mode Receiver Source J6, J8 Right Right Right Left Right
5-19 Common Mode

Operating DC Voltage
Source J6, J8 Right Right Right Left Right

5-20 Single Mode Operating
DC Voltage

Source J6, J8 Right Right Right Left Right

xxx

Set Up the Jumpers on the HEAC-TPA-MAIN Fixture
The following diagram shows the fixture configuration jumpers on the HEAC-TPA-MAIN fixture.

24 TekExpress HEAC Automated Solution



How To Set Up the Jumpers on the HEAC-TPA-MAIN Fixture

The following table shows the jumper settings to configure on the HEAC-TPA-MAIN fixture.

Table 9: HEAC-TPA-MAIN jumper setup

Test ID Description
Termi-
nation

Signal source
output
impedance JP1 JP2 JP3 JP4

5-1 to 5-5 Differential Mode
Transmitter

50 Ω - ON OFF ON OFF

5-6 to 5-10 Common Mode
Transmitter

50 Ω - ON OFF ON OFF

5-11 to 5-15 Single Mode
Transmitter

55 Ω - OFF OFF OFF OFF

110 Ω OFF OFF OFF OFF
100 Ω ON OFF ON OFF

5-16 Differential Mode
Receiver

-

90 Ω ON ON ON ON
5-17 to 5-19 Common Mode

Receiver
- 50 Ω ON OFF ON OFF

5-18 to 5-20 Single Mode
Receiver

- 55 Ω OFF OFF OFF OFF

xxx
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Select the Test(s)
The application tests HEAC transmitter and receiver devices for compliance. Use the Select panel
to select, configure, and run the tests.
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This panel provides the following functions:

Select Device
Select the Device type. The test suite options will be automatically updated according to the selected
device.

Select Test Suite
The application allows you to select a subset of tests to execute, such as Differential-Tx and Differential-Rx.
Based on the selected test suite, different measurement lists will be populated and can be configured.

Version
Select the appropriate version. For example, CTS 1.4.

The table has the following two columns:

Select: Include or exclude any test for analysis.

Test Name: Displays the name of the test.

NOTE. If any of the check boxes in the Select column is grayed, you cannot make any changes. It implies
that the test is mandatory.

Once you select a row, the following options are available:

Table 10: Button controls on the Select panel
Button Description

Opens the configuration panel for the selected test.

Opens the equipment setup diagram for the selected test. This is useful
if you want to verify the test setup before running the test.

Selects all tests in the table.

Deselects all tests in the table.

xxx
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Configure and Run the Test(s)
The configuration panel is used to create, view, and edit the parameters associated with the acquisition and
the analysis of the selected test. In the Select panel, click Configure.

In the Configure panel, you have the following options:

Choose to run the tests in Compliance or User Defined Mode.

Reload compliance mode values.

Change the parameters associated with the configuration of acquisition.

Change the parameters associated with analysis configuration.

Change the test limits in User Defined Mode.

The upper part of the Configure panel has editable parameters that are common for all the tests under the
selected test suite. These parameters allow you to:

Select the appropriate instrument.

Specify the channel to which you are connecting the signal.

The lower half of the Configure panel has test-specific parameters.
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NOTE. If any of the test parameters are grayed, it means that these parameters cannot be modified in the
compliance mode. When you switch to the user defined mode, these parameters are editable.

Table 11: Test parameters
Parameters to configure Description
Acquire Shows the various parameters

related to acquisition of a selected
test. These parameters can vary
from one test to another.

Analyze Shows the default analysis
parameters for the selected test.

Limits Applies to a specific test. It shows
the measurement limits using
different types of comparisons.

Comments Enter a comment up to 256
characters long for the selected
test.
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Table 11: Test parameters (cont.)

Parameters to configure Description
Compliance settings

Restores the compliance settings.

Accepts all changes that you made.

Dismisses the dialog box and does
not apply changes.

xxx

Click Run in the Select panel to run the selected tests.

Refer to the following table for different test limit comparisons:

Table 12: Different test limit comparisons
Comparison string Description
EQ(==) Equal to
NE(!=) Not equal to
GT(>) Greater than
LT(<) Less than
GE(>=) Greater than or Equal to
LE(<=) Less than or Equal to
GTLT(><) Greater than and Less than
GELT(>=<) Greater than or equal to and Less than
GTLE(><=) Greater than and Less or equal to
LTGT(<>) Less than and Greater than
LEGE(<= >=) Less than or equal to and Greater than or equal to
LEGT(<= >) Less than or equal to and Greater than
LTGE(< >=) Less than and Greater than or equal to
GELE(>= =<) Greater than or equal to and Less than or equal to
xxx
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View and Select Connected Instruments

Viewing Connected Instruments
The Tools > Instrument Bench menu item is used to discover connected instruments that are required for
the tests. The application uses TekVISA to discover the connected instruments. Once the operation is
done, the Instrument Bench dialog box resumes operation and lists the instrument-related details based
on the selected search criteria.

NOTE. When the TekVISA Instrument Manager checks for connected Instruments, the Instrument Bench
dialog box does not respond.

For example, if you select GPIB as the search criteria in the Instrument Bench dialog and click Refresh,
the TekVISA Instrument Manager checks for the instruments availability over GPIB and the details of
the instrument are displayed under Retrieved Instruments table.

You can provide the time in the TekVISA Timeout (Seconds) field, within which if the TekVISA
Instrument Manager does not find the instruments, the TekExpress application resumes the operation.

If you choose Non-VISA resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.
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Selecting Connected Instruments
You can view the connected instruments in the Configuration panel. The upper half of the panel displays
the general parameters for the tests under the selected test suite.

Choose the instruments from the drop-down list as shown in the following figure:

NOTE. The list of instruments displayed is specific to the selected test suite. It does not show all of the
connected instruments.

Use Prerecorded Waveforms for Analysis
From the Acquire tab, you can see unique acquisitions, acquisition parameters, acquisition status, and
prerecorded waveform files of the selected test suite. The Acquire panel is specific to a suite and gets
updated every time the selected test suite is changed. This panel shows the acquisition details for the tests
in the currently selected suite. The tests with the common acquisition parameters are grouped together and
shown as a single acquisition.

Prerecorded waveforms are available only for Differential Receiver analysis.

NOTE. You can use prerecorded waveforms only when a session is saved.
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Column name Function
Acquisition Acquisition Name
Test Name of the tests performing acquisitions. One or more test can perform the

same acquisitions.
Status Test acquisition status of the running test passed at intervals.
Waveform File(s) Prerecorded waveform files of unique acquisitions. Select waveform files by

selecting browse on individual cells. This allows you to select any waveform file
using the standard file open window.

xxx

The following Acquire source options are available:

Use Prerecorded Waveform files: Enabling or disabling the option shows or hides the waveform
file column in the acquisition table.

When you save a session and then select this option, the DUT ID text box changes to a drop-down
list, in which you can select the DUT ID up to the point where the session was saved. A drop-down
box appears above the Waveform file column, showing the run details, including the date and time of
each run. If you select a run, corresponding data for that run will be populated (such as the selected
test, the test configuration settings, and the test summary status).

Acquire Step by Step: Selecting this prompts you at the end of each acquisition before proceeding
to the next one.

Show Acquire Parameters: On enabling this option, the acquisition parameters for each unique
acquisition is displayed in the acquisition table.

When you select “Use PreRecorded Waveform Files”, the first column shows the waveform type and the
second column shows the tests that use that waveform type for analysis. The following guidelines help you
determine the correct prerecorded waveform for each test to be performed.

TIP. Select "Show Acquire Parameters" to verify the acquire parameters and the corresponding waveform.

The following is a list of prerecorded reference waveforms supplied with the application:

Location: \MyTekExpress\HEAC\<SessionName>\<DUT ID>\<yymmdd_hhmmss>

Naming convention: <Acquire_Type><Trial_Number><Test_Name>.wfm

Waveform files:

ARPandPingResponse0WCC.wfm

ARPandPingResponse3CMHigh.wfm

ARPandPingResponse2CMHigh.wfm

ARPandPingResponse1CMHigh.wfm

ARPandPingResponse0CMHigh.wfm

ARPandPingResponse1ClockLow.wfm
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ARPandPingResponse0ClockLow.wfm

ARPandPingResponse0ClockHigh.wfm

ARPandPingResponse0AmplitudeLow.wfm

ARPandPingResponse0AmplitudeHigh.wfm

ARPandPingResponse0Nominal.wfm

ARPResponseTrial0.wfm

View the Progress of Analysis
You can view the progress of the analysis in the Analyze panel. The result value is updated when the
analysis of each test is complete.

Analysis Table
The table contains the following:

The test name.

The status of the tests that are being run.

The measured, limit, and margin values of the tests.
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The tests that are not yet started are shown with a “To be Started” status. A summarized status of the
currently running test is shown on the Status Messages panel.

The Status Messages window timestamps all runtime messages and displays them. You can do the
following:

Display Status: Enable/Disable status messages.

Auto Scroll: The status messages are scrolled automatically.

Clear All: Clear all status messages in Status Window.

Save Status: Save all status messages in text file. Displays a standard save file window and saves the
status messages in the user specified file.

NOTE. The Status Messages window is dockable and can be resized.

View the Report
After the analysis, the application automatically generates a report is which is shown in the report panel.
The report shows the results of the tests, including device information and the pass/fail status of each test.

The Report View Area contains an HTML version of the report template. You can select any area of the
report and copy it to the clipboard to make it available to other application.
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View Test Related Files
All the test related files for currently selected tests are always saved under My Documents\My

TekExpress\HEAC\Untitled Session.

When you save a session, it is saved with the session name under the path My Documents\My

TekExpress\HEAC\SessionName for future references.

The session that is currently running will be stored in the same path as “Untitled” until you save it.

WARNING. Do not save a session named “Untitled” or “Backup” because there are application-specific
files and are deleted when you exit the application.

A session folder can contain results for more than one DUT, and a DUT folder can contain more than one
run data folder marked by date-time stamp as folder name.

The following image shows the directory structure for saved sessions:
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Select a Differential Mode Transmitter Test
In TekExpress, the Select panel allows you to select and configure the transmitter tests.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Transmitter.

3. Select the Test Suite as Differential-Tx. The version is already selected as CTS 1.4.

4. Enter the DUT ID in the field provided.

5. Select a test from the list: Operating DC Voltage, Jitter MAX, Rise-Fall Time, High-Low-Center
Level, Cycle Time and Template Test (Informative).

NOTE. All differential mode transmitter tests, except the Template Test, are selected by default. To select a
particular test, click Deselect All, and select the required test from the list.

Make Connections for a Differential Mode Transmitter Test
For all differential mode transmitter signal tests except the Operating DC Voltage test, you need the
following equipment:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Probe Tektronix P6247, P6248, P6330, or P7330 for a DPO70000
Series, DPO70000B Series, DSA70000 Series, DPO70000B, and
MSO70000 Series Digital and Mixed Signal Oscilloscope
Tektronix P6330, TDP1000, TDP1500 or TDP3500 for a Tektronix
DPO7000 Series Digital Oscilloscope

Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
50 Ω SMA Terminators Any terminator that meets the following requirements:

50 Ω impedance ± 1% or better

Connects directly to the SMA female connector
DUT An HEAC sink or source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

NOTE. To view the equipment setup diagram, click the Show Schematic button.

NOTE. This equipment setup diagram and connections are the same for all differential transmitter tests
except the Operating DC Voltage test.

1. Connect the CEC or CDC Controller to the CEC/CDC Control Port on the HEAC-TPA main board.

2. Connect the HEAC-TPA plug board to the HEAC connector of the Source/Sink DUT.

3. Connect the 50 Ω SMA terminators to the HEAC-TPA main board.

4. Connect a differential probe to the HEAC± differential signal probe point on the HEAC-TPA main
board.
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5. If you are testing a Sink DUT, set the HEAC-TPA main board to enable the Sink DUT test. Set switch
S7 to the left (Off position) on the HEAC-TPA main board.

If you are testing a Source DUT, set the HEAC-TPA main board to enable the Source DUT test.
Activate the +4 V bias by using the +5 V power from the Source DUT. Set switch S7 to the right
(On position) on the HEAC-TPA main fixture.

Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

6. Activate the HEC transmission on the HEAC Source/Sink DUT using the CEC/CDC Controller.

Configure and Run a Differential Mode Transmitter Test
To configure a differential mode transmitter test, do the following:

1. In the Select panel click Configure.

2. In the Configure panel, select either Compliance Mode or User Defined Mode. In the User Defined
Mode, you can modify the test parameters but you will no longer be testing against the compliance
standards. In the Compliance Mode, you cannot modify any of the parameters.

Configure the following general parameters that are common for transmitter tests.

Table 13: General parameters for transmitter tests
Parameter Description
Real time scope Select the oscilloscope to connect to.
DUT signal connected to real time scope at Select the oscilloscope channel to which the DUT signal

is connected.
Minimum signal threshold (mV) Specify the minimum signal threshold value, in mV, for

signal validation.
xxx

NOTE. In the Compliance Mode, none of the acquisition and analysis parameters are editable.

3. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Make Connections for the Operating DC Voltage Test
For a differential mode transmitter operating DC voltage test, you need the following equipment:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Probe Tektronix P6247, P6248, P6330, or P7330 for a DPO70000
Series, DPO70000B Series, DSA70000 Series, DPO70000B, and
MSO70000 Series Digital and Mixed Signal Oscilloscope
Tektronix P6330, TDP1000, TDP1500, or TDP3500 for a Tektronix
DPO7000 Series Digital Oscilloscope

Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC sink or source device
50 Ω SMA Terminators Any terminator that meets the following requirements:

50 Ω impedance ± 1% or better

Connects directly to the SMA female connector
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

Make connections as follows:

1. Connect the CEC or CDC Controller to the CEC/CDC Control Port of the HEAC-TPA main board.

2. Connect the HEAC-TPA plug board to the HEAC connector of the Source/Sink DUT.

3. Connect the 50 Ω SMA terminators to the HEAC-TPA main board.

4. Connect the first single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on
the HEAC-TPA main board, and the second single-ended probe from Ch2 to the HEAC- probe point.

5. If you are testing a Sink DUT, set the HEAC-TPA main board to enable the Sink DUT test. Set switch
S7 to the left (Off position) on the HEAC-TPA main fixture.

If you are testing a Source DUT, set the HEAC-TPA main board to enable the Source DUT test, and
use +5 V power from the DC Power Supply. Set switch S7 to the right (On position) and switch S4 to
the left (Off position) on the HEAC-TPA main fixture.
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NOTE. Do not use +5 V power from the Source DUT.

Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

6. Connect and configure the DC Power Supply to supply +5 V to the HEAC-TPA main board.

7. Power on the Source/Sink DUT.

8. Activate the HEC transmission capability for the HEAC Source/Sink DUT using the CEC/CDC
controller.

Configure and Run the Operating DC Voltage Test
To configure and run the operating DC voltage test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for DC Voltage HEAC+line and
DC Voltage HEAC–line. The following table lists the compliance mode values and the permitted
range of values.

Table 14: Acquisition parameters for the operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 200 100, 200, 400
Vertical Position 0 Do not change
Vertical Offset (V) Auto Auto, 2, 4, 6
Horizontal Scale (μs) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 2500000 1250000, 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

4. Click Analyze. Configure the following analysis parameters:
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Table 15: Analysis parameters for the operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
xxx

5. Click Limits to view and change the DC Voltage HEAC+line and DC Voltage HEAC–line values
and the compare string.

6. Click Comments to enter comments. The comments are shown in the test report.

7. Click Apply to effect the changes, and then click Close.

8. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

9. Follow the on-screen prompts and the schematics to change the setup.

View Analysis of the Operating DC Voltage Test
Click Analyze to view the analysis of the operating DC voltage test.
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Configure and Run the Jitter MAX Test
To configure and run the jitter max test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for MLT3 Jitter. The following
table lists the compliance mode values and the permitted range of values.

Table 16: Acquisition parameters for the jitter max test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 60 30, 40, 60
Vertical Position 0 Do not change
Vertical Offset (V) 0 Do not change
Horizontal Scale (nSec-Div) 10 0, 5, 10
Horizontal Position (%) 50 50, 70, 90
Record Length 1000 500, 1000, 2000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. View and change the following analysis parameters:

NOTE. In the User Defined Mode, adjust the oscilloscope settings and use those settings to perform
the measurements.

Table 17: Analysis parameters for the jitter max test
Parameter Compliance mode
Comm Positive Trigger Data Level Positive (mV) 100
Comm Negative Trigger Data Level Negative (mV) –100
Comm Trigger Standard 100BASE–TX
Comm Trigger Coding MLT3
Comm Trigger Type DATA
Comm Trigger Bit Rate (Mbps) 125
xxx

4. Click Limits to view and change the Positive Pulses JIT-MAX, the Negative Pulses JIT-Max values
(in ns), and the compare string.
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5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Jitter MAX Test
Click Analyze to view the analysis of the jitter max test.

Configure and Run the Rise-Fall Time Test
To configure and run the rise-fall time test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for MLT3-Positive Rise,
MLT3-Positive Fall, MLT3-Negative Rise, and MLT3-Negative Fall. The following table lists the
compliance mode values and the permitted range of values.

Table 18: Acquisition parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 60 40, 60, 80
Vertical Position 0 Do not change
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Table 18: Acquisition parameters for the rise-fall time test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (nSec-Div) 20 10, 20, 50
Horizontal Position (%) 70 50, 70, 90
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

NOTE. In the User Defined Mode, adjust the oscilloscope settings and use those settings to perform
the measurements.

Table 19: Analysis parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Serial Trigger Positive Data Level
(mV)

100 Do not change

Serial Trigger Negative Data Level
(mV)

–100 Do not change

Serial Trigger Pattern for Positive
Pulse

00000000011111 Do not change

Serial Trigger Pattern for Negative
Pulse

11111111100000 Do not change

Serial Trigger Clock Source R Clk Ch3, Ch4, R Clk
Serial Trigger Standard 100BASE-TX GB Ethernet, 100BASE-TX
Serial Trigger Coding NRZ Do not change
Serial Trigger Bit Rate (Mbps) 125 Do not change
xxx

4. Click Limits to view and change the Rise time positive pulse signal, Rise time negative pulse signal,
Fall time positive pulse signal, and Fall time negative pulse signal values (in ns) and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Rise-Fall Time Test
Click Analyze to view the analysis of the rise-fall time test.

Configure and Run the High-Low-Center Level Test
To configure and run the High-Low-Center level test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for MLT-3 High Level, MLT-3
Mid Level, and MLT-3 Low Level. The following table lists the compliance mode values and the
permitted range of values.
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Table 20: Acquisition parameters for the high-low-center level test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 60 40, 60, 80
Vertical Position 0 Do not change
Horizontal Scale (nSec-Div) 20 10, 20, 50
Horizontal Position (%) 70 50, 70, 90
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

NOTE. In the User Defined Mode, adjust the oscilloscope settings and use those settings to perform
the measurements.

Table 21: Analysis parameters for the high-low-center level test
Parameter Compliance mode
Window Trigger Upper Data Level-High Level Voltage (mV) 250
Window Trigger Lower Data Level-High Level Voltage (mV) 150
Window Trigger Upper Data Level-Low Level Voltage (mV) –150
Window Trigger Lower Data Level-Low Level Voltage (mV) –250
Window Trigger Upper Data Level-Center Level Voltage (mV) 50
Window Trigger Lower Data Level-Center Level Voltage (mV) –50
Window Trigger Width (nSec) 80
xxx

4. Click Limits to view and change the (Vep) High level voltage, (Ven) Low level voltage, (Vec) Center
level voltage values (in mV), and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for High-Low-Center Level Test
Click Analyze to view the analysis of the high-low-center level test.

Configure and Run the Cycle Time Test
To configure and run the Cycle Time test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for MLT-3 Positive Cycle and
MLT-3 Negative Cycle. The following table lists the compliance mode values and the permitted
range of values.

Table 22: Acquisition parameters for the cycle time test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 60 40, 60, 80
Vertical Position 0 Do not change
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Table 22: Acquisition parameters for the cycle time test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (nSec-Div) 20 10, 20, 50
Horizontal Position (%) 70 50, 70, 90
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

NOTE. In the User Defined Mode, adjust the oscilloscope settings and use those settings to perform
the measurements.

Table 23: Analysis parameters for the cycle time test

Parameter Compliance mode
Permitted user defined mode
values

Serial Trigger Positive Data Level
(mV)

100 100

Serial Trigger Negative Data Level
(mV)

–100 –100

Serial Trigger Pattern for Positive
Pulse

0100010001000 Do not change

Serial Trigger Pattern for Negative
Pulse

1011101110111 Do not change

Serial Trigger Clock Source R Clk Ch3, Ch4, R Clk
Serial Trigger Standard 100BASE-TX GB Ethernet, 100BASE-TX
Serial Trigger Coding NRZ Do not change
Serial Trigger Bit Rate (Mbps) 125 Do not change
xxx

4. Click Limits to view and change the Positive Cycle Time, Negative Cycle Time values (in ns), and the
compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Cycle Time Test
Click Analyze to view the analysis of the cycle time test.

Configure and Run the Template Test
The template test is purely informative and only the User Defined Mode is available. To configure and
run the template test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. The following table lists the compliance mode values and the permitted range of values for the user
defined mode.

Table 24: Acquisition parameters for the template test

Parameter Default values
Permitted user defined mode
values

Vertical Scale (mV-Div) 60 20, 60, 200
Vertical Position 0 Do not change
Vertical Offset (V) 0 Do not change

52 TekExpress HEAC Automated Solution



How To Configure and Run the Template Test

Table 24: Acquisition parameters for the template test (cont.)

Parameter Default values
Permitted user defined mode
values

Horizontal Scale (nSec-Div) 4 0, 4, 8
Horizontal Position (%) 50 50, 70, 90
Record Length 1000 500, 1000, 2000
Delay Mode ON ON, OFF
Horizontal Delay (nSec) 80 80, 100
Mask Pass-Fail Test Samples 1000000 Do not change
xxx

3. Click Analyze. Configure the following analysis parameters:

Table 25: Analysis parameters for the template test
Parameter Default values
Comm Trigger Data Level (absolute mV) 100
Comm Trigger Standard 100BASE-TX
Comm Trigger Coding MLT3
Comm Trigger Type DATA
Comm Trigger Bit Rate (Mbps) 125
Mask File Path HEAC.msk
xxx

4. Click Limits to view and change the Hit Count values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Template Test
Click Analyze to view the analysis of the template test. The results do not show pass or fail because the
template test is not a compliance test.
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View Results for the Differential Mode Transmitter Tests
You can view the differential mode transmitter test results in the Analyze panel. A table shows the test
name, status of the test, measurement details, CRC status, and the pass/fail status. The application also
automatically displays a report in the Report panel once the test is successfully completed. Save this report
as an MHT file using the File > Save As option.

The following screen shows the results for differential mode transmitter tests.

Select a Common Mode Transmitter Test
In TekExpress, the Select panel allows you to select and configure the transmitter tests.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Transmitter.

3. Select the Test Suite as CommonMode-Tx. The version is already selected as CTS 1.4.

4. Enter the DUT ID in the field provided.

5. Select a test from the list: Operating DC Voltage, High-Low-Center Level, Rise-Fall Time,
Transmit Jitter MAX/Clock Frequency, and IEC 60958-1 Stream Verification.
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NOTE. All common mode transmitter tests are selected by default. To select a particular test, click
Deselect All, and select the required test from the list.

Make Connections for a Common Mode Transmitter Test
For a common mode transmitter signal test, you need the following equipment:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Probe Tektronix P6243 or P6245 for Tektronix DPO70000 Series,
DPO70000B Series, DSA70000 Series, and DSA70000B Series, and
MSO7000 Series Digital and Mixed Oscilloscopes
Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series
Digital Oscilloscopes

NOTE. You can also use two differential probes in single-ended
mode.

Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC sink device
50 Ω SMA Terminators Any terminator that meets the following requirements:

50 Ω impedance ± 1% or better

Connects directly to the SMA female connector
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

NOTE. To view the equipment setup diagram, click the Show Schematic button.

1. Connect the CEC or CDC Controller to the CEC/CDC Control Port of the HEAC-TPA main board.

2. Connect the HEAC-TPA plug board to the HEAC connector of the Sink DUT.

3. Connect the 50 Ω terminators to the HEAC-TPA main board.

4. Connect the first single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on
the HEAC-TPA main board, and the second single-ended probe from Ch2 to the HEAC- probe point.

5. Set the HEAC-TPA main board to enable the Sink DUT test.

Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)
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6. Connect and configure DC Power Supply to drive +5 V to the HEAC-TPA main board. Set switch S7
to the left (Off position) on the HEAC-TPA main fixture.

7. Power on the Sink DUT.

8. Activate the ARC (Common mode) transmission on the HEAC Sink DUT using the CEC/CDC
controller.

Configure and Run a Common Mode Transmitter Test
To configure a common mode transmitter test, do the following:

1. In the Select panel click Configure.

2. In the Configure panel, select either Compliance Mode or User Defined Mode. In the User Defined
Mode, you can modify the test parameters but you will no longer be testing against the compliance
standards. In the Compliance Mode, you cannot modify any of the parameters.

Configure the following general parameters that are common for transmitter tests.

Table 26: General parameters for common mode transmitter tests
Parameter Description
Real time scope Select the oscilloscope to which to connect.
DUT High Signal connected to real time scope at Select the oscilloscope channel to which the DUT high

signal is connected.
DUT Low Signal connected to real time scope at Select the oscilloscope channel to which the DUT low signal

is connected.
Minimum signal threshold (mV) Specify the minimum signal threshold value, in mV, for

signal validation.
xxx

NOTE. In the Compliance Mode, none of the acquisition and analysis parameters are editable.

3. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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Configure and Run the Operating DC Voltage Test
To configure and run the operating DC voltage test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for DC Voltage HEAC+line and
DC Voltage HEAC–line. The following table lists the compliance mode values and the permitted
range of values.

Table 27: Acquisition parameters for the operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 200 100, 200, 400
Vertical Position (div) 0 Do not change
Vertical Offset (V) Auto Auto, 2, 4, 6
Horizontal Scale (μs) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 2500000 1250000, 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 28: Analysis parameters for the operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
xxx

4. Click Limits to view and change the DC Voltage HEAC+line and DC Voltage HEAC–line values
and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Operating DC Voltage Test
Click Analyze to view the analysis of the operating DC voltage test.

Configure and Run the High-Low Level Test
To configure and run the high-low level test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF High Level and SPDIF
Low Level. The following table lists the compliance mode values and the permitted range of values.

Table 29: Acquisition parameters for the high-low level test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
Vertical Offset (V) 4 2, 4, 6
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Table 29: Acquisition parameters for the high-low level test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (μs) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 5000000 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 30: Analysis parameters for the high-low level test
Parameter Compliance mode Permitted user defined mode values
Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
High Level: Histogram Top Limit (mV) 260 Do not change
High Level: Histogram Bottom Limit
(mV)

150 Do not change

Low Level: Histogram Top Limit (mV) –150 Do not change
Low Level: Histogram Bottom Limit
(mV)

–260 Do not change

xxx

4. Click Limits to view and change the (+Vei swing) High Level and (–Vei swing) Low Level values
and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for High-Low Level Test
Click Analyze to view the analysis of the high-low level test.

Configure and Run the Rise-Fall Time Test
To configure and run the rise-fall time test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Rise, SPDIF Fall,
SPDIF-MLT3 Rise, and SPDIF-MLT3 Fall. The following table lists the compliance mode values and
the permitted range of values.

Table 31: Acquisition parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
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Table 31: Acquisition parameters for the rise-fall time test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Vertical Offset (V) 4 2, 4, 6
Horizontal Scale (ns) 100 50, 100, 200
Horizontal Position (%) 70 50, 70, 90
Record Length 50000 25000, 50000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 32: Analysis parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Serial Trigger Data Level (V) 4 2, 4, 6
Serial Trigger Pattern for Rise-time 0011 Do not change
Serial Trigger Pattern for Fall-time 1100 Do not change
Serial Trigger Clock Source R Clk Ch 3, Ch 4, R Clk
Serial Trigger Standard Custom Do not change
Serial Trigger Coding NR2 Do not change
Serial Trigger Bit Rate (Mbps) 6.144 4.096, 5.6448, 6.144
Math1 Vertical Position (div) –66 Do not change
Math1 Scale (mV) 60 40, 60, 80
xxx

4. Click Limits to view and change the Rise time and Fall time values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

8. Follow the on-screen instructions. When prompted, configure the DUT to transmit or disable an
MLT-3 signal.
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View Analysis for Rise-Fall Time Test
Click Analyze to view the analysis of the rise-fall time test.

Configure and Run the Transmit Jitter MAX-Clock Frequency Test
To configure and run the transmit jitter MAX-clock frequency test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Clock 6.144 MHz,
SPDIF Clock 5.6488 MHz, and SPDIF Clock 4.096 MHz. The following table lists the compliance
mode values and the permitted range of values.

Table 33: Acquisition parameters for the transmit jitter MAX-clock frequency test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
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Table 33: Acquisition parameters for the transmit jitter MAX-clock frequency test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Vertical Offset (V) 4 2, 4, 6
Horizontal Scale (ms) 2 1, 2, 4
Horizontal Position (%) 50 50, 70, 90
Sample Rate (GS/s) 1.25 1, 1.25, 1.5
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 34: Analysis parameters for the transmit jitter MAX-clock frequency test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
Math1 Position –40 –35, –40, –45
Math1 Vertical Scale (mV) 50 40, 50, 60
Math2 Position 0 –5, 0, 5
Math2 Vertical Scale (mV) 60 40, 60, 80
Clock Recovery - CUSTOM BW (Hz) 700 Do not change
Clock Recovery - PLL ORDER) Type I Type I, Type II
xxx

4. Click Limits to view and change the Jitter MAX and Clock Frequency values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

8. The Transmit Jitter MAX test is run at three frequencies. The application prompts you to configure the
DUT for each of these frequencies: 4.096 MHz, 5.688 MHz, and 6.144 MHz. If your device supports
the frequency, configure the DUT for the frequency when prompted.

9. If your DUT frequency is not supported, then select Not Supported and proceed to next step to
set at other frequency.
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View Analysis for Transmit Jitter MAX-Clock Frequency Test
Click Analyze to view the analysis of the transmit jitter MAX-clock frequency test.

Configure and Run the IEC60958-1 Stream Verification Test
To configure and run the IEC60958-1 stream verification test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF. The following table
lists the compliance mode values and the permitted range of values.

Table 35: Acquisition parameters for the IEC60958-1 stream verification test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
Vertical Offset (V) 0 –2, 0, 2
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Table 35: Acquisition parameters for the IEC60958-1 stream verification test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (ms) 2 1, 2, 4
Horizontal Position (%) 50 50, 70, 90
Sample rate (MS/s) 125 100, 125, 150
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 36: Analysis parameters for the IEC60958-1 stream verification test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
Math1 Position (div) –40 –35, –40, –45
Math1 Vertical Scale (mV) 100 80, 100, 120
xxx

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. The IEC Stream Verification test is run under three conditions: With +5 V power turned on and ARC
activated, With +5 V power turned off, and With +5 V power turned on and ARC not activated. Follow
the on-screen prompts to run the test using the three conditions.
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View Analysis for IEC60958-1 Stream Verification Test
Click Analyze to view the analysis of the IEC60958-1 stream verification test.
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View Results for the Common Mode Transmitter Tests
You can view the common mode transmitter test results in the Analyze panel. A table shows the test name,
status of the test, measurement details, high and low limits, margins, units, and the pass/fail status. The
application also automatically displays a report in the Report panel once the test is successfully completed.
Save this report as an MHT file using the File > Save As option.

The following screen shows the results for common mode transmitter tests.
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Select a Single Mode Transmitter Test
In TekExpress, the Select panel allows you to select and configure the transmitter tests.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Transmitter.

3. Select the Test Suite as SingleMode-Tx. The version is already selected as CTS 1.4.

4. Enter the DUT ID in the field provided.

5. Select a test from the list: Operating DC Voltage, Signal Amplitude, Rise-Fall Time, Transmit
Jitter MAX/Clock Frequency, and IEC 60958-1 Stream Verification.

NOTE. All single mode transmitter tests are selected by default. To select a particular test, click Deselect
All, and select the required test from the list. You cannot deselect the Operating DC Voltage test.

Make Connections for a Single Mode Transmitter Test
For a single mode transmitter signal test, you need the following equipment:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Probe Tektronix P6243 or P6245 for Tektronix DPO70000 Series,
DPO70000B Series, DSA70000 Series, and DSA70000B Series, and
MSO7000 Series Digital and Mixed Oscilloscopes
Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series
Digital Oscilloscopes

NOTE. You can also use two differential probes in single-ended
mode.

Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC sink device
50 Ω SMA Terminators Any terminator that meets the following requirements:

50 Ω impedance ± 1% or better

Connects directly to the SMA female connector
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

NOTE. To view the equipment setup diagram, click the Show Schematic button.

1. Connect the CEC or CDC Controller to the CEC/CDC Control Port on the HEAC-TPA main board.

2. Connect the HEAC-TPA plug board to the HEAC connector on the Sink DUT.

3. Connect the 50 Ω SMA terminators to the HEAC-TPA main board.

4. Set the Impedance Conversion Circuit on the HEAC-TPA main board to 55 Ω:

See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

5. Connect a single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on
the HEAC-TPA main board.

6. Set the HEAC-TPA main board to enable the Sink DUT test.
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7. Connect and set the DC Power Supply to supply +5 V to the HEAC-TPA main board. Set switch S7 to
the left (Off position) on the HEAC-TPA main fixture.

8. Power on the Sink DUT.

9. Activate the ARC (Single mode) transmission on the HEAC Sink DUT using the CEC/CDC controller.

Configure and Run a Single Mode Transmitter Test
To configure a single mode transmitter test, do the following:

1. In the Select panel click Configure.

2. In the Configure panel, select either Compliance Mode or User Defined Mode. In the User Defined
Mode, you can modify the test parameters but you will no longer be testing against the compliance
standards. In the Compliance Mode, you cannot modify any of the parameters.

Configure the following general parameters that are common for transmitter tests.

Table 37: General parameters for single mode transmitter tests
Parameter Description
Real time scope Select the oscilloscope to which to connect.
DUT HEAC+ signal connected to real time scope at Select the oscilloscope channel to which to connect the

DUT signal.
Minimum signal threshold (mV) Specify the minimum signal threshold value, in mV, for

signal validation.
xxx

NOTE. None of the acquisition and analysis parameters are editable in the Compliance Mode.

3. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Configure and Run the Operating DC Voltage Test
To configure and run the operating DC voltage test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for HEAC DC Voltage. The
following table lists the compliance mode values and the permitted range of values.

NOTE. You cannot deselect the Operating DC Voltage test.
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Table 38: Acquisition parameters for the operating DC voltage test (single mode)

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 100, 200, 400
Vertical Position (div) 0 Do not change
Vertical Offset (V) Auto Auto, 2, 3, 4
Horizontal Scale (μs) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 2500000 1250000, 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 39: Analysis parameters for the operating DC voltage test (single mode)

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 0.5 0.5, 1.0, 1.5
Edge Trigger Slope Positive Positive, Negative
xxx

4. Click Limits to view and change the DC Voltage:Vel (V) values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Operating DC Voltage Test
Click Analyze to view the analysis of the operating DC voltage test.
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Configure and Run the Signal Amplitude Test
To configure and run the high-low level test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Level. The following
table lists the compliance mode values and the permitted range of values.

Table 40: Acquisition parameters for the signal amplitude test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
Vertical Offset (V) 4 2, 4, 6
Horizontal Scale (μs) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 5000000 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 41: Analysis parameters for the signal amplitude test
Parameter Compliance mode Permitted user defined mode values
Edge Trigger Level (V) 0.5 0.5, 1.0, 1.5
Edge Trigger Slope Positive Positive, Negative
xxx

4. Click Limits to view and change the Vel Swing Level values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Signal Amplitude Test
Click Analyze to view the analysis of the high-low level test.

Configure and Run the Rise-Fall Time Test
To configure and run the rise-fall time test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Rise and SPDIF Fall.
The following table lists the compliance mode values and the permitted range of values.

Table 42: Acquisition parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
Vertical Offset (V) 4 2, 4, 6
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Table 42: Acquisition parameters for the rise-fall time test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (ns) 100 50, 100, 200
Horizontal Position (%) 70 50, 70, 90
Record Length 50000 25000, 50000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 43: Analysis parameters for the rise-fall time test

Parameter Compliance mode
Permitted user defined mode
values

Serial Trigger Data Level (V) 4 2, 4, 6
Serial Trigger Pattern for Rise-time 0011 Do not change
Serial Trigger Pattern for Fall-time 1100 Do not change
Serial Trigger Clock Source R Clk Ch 3, Ch 4, R Clk
Serial Trigger Standard Custom Do not change
Serial Trigger Coding NRZ Do not change
Serial Trigger Bit Rate (Mbps) 6.144 4.096, 5.6448, 6.144
xxx

4. Click Limits to view and change the Rise Time and Fall Time values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Rise-Fall Time Test
Click Analyze to view the analysis of the rise-fall time test.

Configure and Run the Transmit Jitter MAX-Clock Frequency Test
To configure and run the transmit jitter MAX-clock frequency test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Clock 6.144 MHz,
SPDIF Clock 5.6488 MHz, and SPDIF Clock 4.096 MHz. The following table lists the compliance
mode values and the permitted range of values.

Table 44: Acquisition parameters for the transmit jitter MAX-clock frequency test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
Vertical Offset (V) 4 2, 4, 6
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Table 44: Acquisition parameters for the transmit jitter MAX-clock frequency test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Horizontal Scale (ms) 2 1, 2, 4
Horizontal Position (%) 50 50, 70, 90
Sample Rate (GS/s) 1.25 1, 1.25, 1.5
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 45: Analysis parameters for the transmit jitter MAX-clock frequency test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
Math1 Position –40 –35, –40, -45
Math1 Vertical Scale (mV) 50 40, 50, 60
Math1 Position (div) 0 –5, 0, 5
Math1 Vertical Scale (mV) 60 40, 60, 80
Clock Recovery - CUSTOM BW (Hz) 700 Do not change
Clock Recovery - PLL ORDER) Type I Type I, Type II
xxx

4. Click Limits to view and change the Jitter MAX and Clock Frequency values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

8. Follow the on-screen prompts to test the DUT for the available frequencies. The Transmit Jitter
MAX test is run at three frequencies. The application prompts you to configure the DUT for each of
these frequencies: 4.096 MHz, 5.688 MHz, and 6.144 MHz. If your device supports the frequency,
configure the DUT for the frequency and proceed with measurement.
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View Analysis for Transmit Jitter MAX-Clock Frequency Test
Click Analyze to view the analysis of the transmit jitter MAX-clock frequency test.

Configure and Run the IEC60958-1 Stream Verification Test
To configure and run the IEC60958-1 stream verification test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. Select the User Defined Mode to configure the following parameters for SPDIF Without +5 V DC
Supply and SPDIF With +5 V DC Supply. The following table lists the compliance mode values and
the permitted range of values.

Table 46: Acquisition parameters for the IEC60958-1 stream verification test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 100 50, 100, 200
Vertical Position (div) 0 Do not change
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Table 46: Acquisition parameters for the IEC60958-1 stream verification test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Vertical Offset (V) 0 –2, 0, 2
Horizontal Scale (ms) 2 1, 2, 4
Horizontal Position (%) 50 50, 70, 90
Sample rate (MS/s) 125 100, 125, 150
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following analysis parameters:

Table 47: Analysis parameters for the IEC60958-1 stream verification test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level (V) 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
xxx

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. The IEC Stream Verification test is run under three conditions: With +5 V power turned on and ARC
activated, With +5 V power turned off, and With +5 V power turned on and ARC not activated. Follow
the on-screen prompts to run the test using the three conditions.
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View Analysis for IEC60958-1 Stream Verification Test
Click Analyze to view the analysis of the IEC60958-1 stream verification test.
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View Results for Single Mode Transmitter Tests
You can view the results in the Analyze panel. A table shows the test name, status of the test, measurement
details, high and low limits, margin, and the pass/fail status. The application also automatically displays
a report in the Report panel once the test is successfully completed. Save this report as an MHT file
using the File > Save As option.

The following screen shows the results for single mode transmitter tests.

TekExpress HEAC Automated Solution 83



How To Select a Differential Receiver Test

Select a Differential Receiver Test
In TekExpress, the Select panel allows you to select, configure and run the receiver tests.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Receiver.

3. Select the test suite as Differential-Rx and the version is CTS 1.4.

4. Enter the IP Address of the DUT. By default, Auto Detect MAC Address is enabled. If you disable
MAC Address, enter the MAC address in the field provided.

5. Enter the DUT ID in the field provided.

6. Select a test from the list: Nominal Response, Receiver Performance-Amplitude, Receiver
Performance-Clock Frequency, Receiver Performance-Common Mode, Receiver
Performance-Signal Source Impedance and Receiver Performance-Worst Case Cable.

NOTE. By default, all receiver tests are selected. To select a particular test, click Deselect All, and select
the required test from the table.

Make Connections for a Differential Receiver Test
You need the following equipment to perform a differential receiver test:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Arbitrary waveform generator Tektronix AWG5000 Series, AWG5000B Series, AWG7000 Series, or
AWG7000B Series Arbitrary Waveform Generators

Probe Tektronix P6247, P6248, P6330, or P7330 for a DPO70000
Series, DPO70000B Series, DSA70000 Series, DPO70000B, and
MSO70000 Series Digital and Mixed Signal Oscilloscope
Tektronix P6330, TDP1000, TDP1500, or TDP3500 for a Tektronix
DPO7000 Series Digital Oscilloscope

Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC sink or source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

NOTE. To view the equipment setup diagram, click the Show Schematic button.

1. Connect a LAN cross-cable from the digital oscilloscope to the waveform generator, and enable the
TekVISA connection to the waveform generator and to the digital oscilloscope.

2. Connect an SMA cable to the Ch1 Marker1 output and to Ch2 on the digital oscilloscope.

3. Connect the HEAC-TPA plug board to the HEAC connector of the Source/Sink DUT.

4. Connect the Ch1 Analog(+) output of the arbitrary waveform generator to the HEAC+ SMA connector
on the HEAC-TPA main board and the Ch2 Analog(+) to HEAC– SMA connector.

5. Set the Impedance Conversion Circuit on the HEAC-TPA main board to 50 Ω:

See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)
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6. Connect a differential probe to the HEAC± differential signal probe point on the HEAC-TPA main
board.

7. Connect the CEC or CDC Controller to CEC/CDC Control Port of the HEAC-TPA main board.

8. If you are testing a Sink DUT, set the HEAC-TPA main board to enable the Sink DUT test. Set switch
S7 position to the left (Off) on the HEAC-TPA main board.

If you are testing a Source DUT, set the HEAC-TPA main board to enable the Source DUT test.
Activate +4 V bias by using the +5 V power from the Source DUT. Set switch S7 to the right (On
position) on the HEAC-TPA main fixture.

9. Activate the HEC transmission on the HEAC Source/Sink DUT using the CEC/CDC controller.

Configure and Run a Differential Receiver Test
To configure and run a differential receiver test, do the following:

1. In the Select panel click Configure.

2. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

Table 48: General parameters for receiver tests
Parameter Description
Real time scope Select the oscilloscope to which to connect.
Signal Source Select the signal source for the test.
DUT signal connected to real time scope at Select the oscilloscope channel to which the DUT signal

is connected.
AWG Marker signal connected to real time scope at Select the oscilloscope channel to which the AWG marker

signal is connected.
Minimum signal threshold (mV) Specify the minimum signal threshold value in mV.
Number of retries for DUT response Specify the number of retries if there is no response from

the DUT.
Synthesis patterns every time Specify whether to synthesize patterns every time the DUT

address changes.
xxx
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Configure and Run the Nominal Response Test
Before you perform the Differential Receiver test, check whether the receiver is responding to a nominal
level of the signal without any impairment to it. Nominal response ensures that the receiver is responding
to the packet sent by the AWG signal . This is required to ensure that the receiver is working properly at
nominal signal levels.

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters for ARP and ARP + Ping:Nominal are defined as in the
following table. It is recommended that you do not change these values.

NOTE. The Compliance Mode is not available for the Nominal Response test.

Table 49: Acquisition parameters for the nominal response test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

NOTE. The Analyze and Limits tabs have no configurable parameters.

3. Click Comments to enter comments. The comments are shown in the test report.

4. Click Apply to effect the changes, and then click Close.

5. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Nominal Response Test
Click Analyze to view the analysis of the nominal response test.
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Configure and Run the Receiver Performance Amplitude Test
To configure and run the receiver performance amplitude test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the Compliance Mode, the acquisition parameters for ARP, ARP + Ping: Amplitude High, and ARP
+ Ping: Amplitude Low are defined as follows:

Table 50: Acquisition parameters for the receiver performance amplitude test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

3. Click Analyze. Configure the +/– Amplitude Variation (%) parameter.

4. Click Limits to view the parameter values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Receiver Performance Amplitude Test
Click Analyze to view the analysis of the receiver performance amplitude test.
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Configure and Run the Receiver Performance Clock Frequency Test
To configure and run the receiver performance clock frequency test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the Compliance Mode, the parameters for ARP, ARP + Ping: Clock Frequency High, and ARP +
Ping: Clock Frequency Low are defined as follows:

Table 51: Acquisition parameters for the receiver performance clock frequency test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

3. Click Analyze. Configure the +/– Clock Frequency Variation (%) parameter.

4. Click Limits to view the parameter values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Receiver Performance Clock Frequency Test
Click Analyze to view the analysis of the receiver performance clock frequency test.
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Configure and Run the Receiver Performance Common Mode Test
To configure and run the receiver performance common mode test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the Compliance Mode, the parameters for ARP and ARP + Ping: Common Mode (high) are defined
as follows:

Table 52: Acquisition parameters for the receiver performance common mode test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

3. Click Analyze. Configure the + Common Mode Variation (%) parameter.

4. Click Limits to view the parameter values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Receiver Performance Common Mode Test
Click Analyze to view the analysis of the receiver performance common mode test.
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Configure and Run the Receiver Performance Signal Source Impedance
Test

To configure and run the receiver performance signal source impedance test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the Compliance Mode, the parameters for ARP, ARP + Ping: Impedance High, and ARP + Ping:
Impedance Low are defined as follows:

Table 53: Acquisition parameters for the receiver performance signal source impedance test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

3. Click Analyze. Configure the Impedance Variation (%) parameter.

4. Click Limits to view the parameter values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Receiver Performance Signal Source Impedance Test
Click Analyze to view the analysis of the receiver performance common mode.
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Configure and Run the Receiver Performance Worst Case Cable Test
To configure and run the receiver performance worst case cable test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the Compliance Mode, the parameters for ARP and ARP + Ping: Worst Case Cable are defined
as follows:

Table 54: Acquisition parameters for the receiver performance common mode test
Parameter Default
Differential Mode Amplitude 0.4
Common Mode Amplitude 0.4
Clock Frequency (MHz) 125
xxx

3. Click Analyze. Change the Worst case cable filter file, if required.

4. Click Limits to view the parameter values and the compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.
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View Analysis for Receiver Performance Worst Case Cable Test
Click Analyze to view the analysis of the receiver performance common mode.
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View Results for a Differential Mode Receiver Test
You can view the results in the Analyze panel. A table shows the test name, status of the test, measurement
details, CRC status, and the pass/fail status. The application also automatically displays a report in the
Report panel once the test is successfully completed. Save this report as an MHT file using the File >
Save As option.

The following screen shows the results for differential mode receiver tests.
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Select a Common Mode Receiver Test
In TekExpress, the Select panel allows you to select, configure and run the common mode receiver tests.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Receiver.

3. Select the test suite as Common Mode-Rx and the version is CTS 1.4.

4. Enter the DUT ID in the field provided.

5. Select a test from the table: Receiver Performance-Nominal Response, Receiver
Performance-Differential Signal Disturbance, Receiver Performance-Jitter Tolerance, Receiver
Performance-Maximum Input, Receiver Performance-Minimum Input, and Operating DC
Voltage.

NOTE. All common mode receiver tests are selected by default. To select a particular test, click Deselect
All, and select the required test from the table.

Make Connections for a Common Mode Receiver Test
You will need the following equipment to perform a common mode receiver test:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Arbitrary waveform generator Tektronix AWG5000 Series, AWG5000B Series, AWG7000 Series, or
AWG7000B Series Arbitrary Waveform Generator

HEAC TPA-P adapter Tektronix HEAC-TPA-P
Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable Any
xxx
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Connect the equipment as shown in the following diagram:

NOTE. To view the equipment setup diagram, click the Show Schematic button.

NOTE. This equipment setup diagram and connections are the same for all common mode receiver tests
except the Operating DC Voltage test.

1. Connect the HEAC-TPA plug board to the HEAC connector on the Source DUT.

2. Connect the CEC or CDC Controller to the CEC/CDC Control Port of the HEAC-TPA main board.

3. Connect the Ch1 Analog(+) output from a waveform generator to the HEAC+ SMA connector of the
HEAC-TPA main board, and the Ch2 Analog(+) to the HEAC– SMA connector.

4. Set the Impedance Conversion Circuit on the HEAC-TPA main board to 50 Ω:
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See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

5. Set the HEAC-TPA main board to enable the Source DUT test.

6. Activate +4 V bias using the +5 V power from the Source DUT.

7. Activate ARC (Common mode) transmission capability for the HEAC Source DUT using the
CEC/CDC controller.
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Configure and Run a Common Mode Receiver Test
To configure and run a common mode receiver test, select one or more tests and do the following:

1. In the Select panel click Configure.

NOTE. The nominal response test is provided (although not part of the CTS 1.4) for you to test whether
your DUT is working with nominal signal levels. The Compliance Mode is not available for the Nominal
Response test.

Table 55: General parameters for common mode receiver tests
Parameter Description
Signal Source Select the arbitrary waveform generator as the signal

source.
Real Time Scope Select the oscilloscope to which to connect.
DUT High Signal connected to real time scope at Select the oscilloscope channel to which the DUT High

signal is connected.
DUT Low Signal connected to real time scope at Select the oscilloscope channel to which the DUT Low

signal is connected.
xxx

NOTE. The Analyze and Limits tabs have no configurable parameters.

2. Click Comments to enter comments. The comments are shown in the test report.

3. Click Apply to effect the changes, and then click Close.

4. In the Select panel, click Run to start the test. This loads the pattern file(s) for the test. As each
test executes, you are prompted to verify the audio response from the DUT. If you detect the audio
response, click Detected. If you do not detect the audio response, click Not Detected. The Acquire
panel shows the progress and status of the test as it runs.

If you select Detected, the Analyze panel is updated with the audio tone as detected and the test is
reported as Pass.

If you select Not Detected, the Analyze panel is updated with the audio tone as not detected and
the test is reported as Fail.

5. After the selected tests are executed, a report is generated and displayed in the Report panel.
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Configure and Run the Receiver Performance Nominal Response Test
To configure and run the receiver performance nominal response test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 56: Acquisition parameters for the receiver performance nominal response test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Nominal
Response.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for Nominal Pattern 2 Do not change
xxx

NOTE. The Analyze and Limits tabs have no configurable parameters.

3. Click Comments to enter comments. The comments are shown in the test report.

4. Click Apply to effect the changes, and then click Close.

5. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

6. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.
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View Analysis for Receiver Performance Nominal Response Test
Click Analyze to view the analysis of the receiver performance nominal response test.
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Configure and Run the Receiver Performance Differential Signal
Disturbance Test

To configure and run the receiver performance differential signal disturbance test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 57: Acquisition parameters for the receiver performance differential signal disturbance test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Differential
Signal Disturbance.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for 48KHz (6.144MHz) 2 Do not change
xxx

3. Click Analyze. Configure the Differential Signal Disturbance (%) parameter.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.
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View Analysis for Receiver Performance Differential Signal Disturbance
Test

Click Analyze to view the analysis of the receiver performance differential signal disturbance test.
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Configure and Run the Receiver Performance Jitter Tolerance Test
To configure and run the receiver performance jitter tolerance test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 58: Acquisition parameters for the receiver performance jitter tolerance test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Jitter
Tolerance.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
Pattern for 10UI, 5Hz@6.144MHz Jit-

ter5Hz10UI48k400Hz1kHz400mV_c
Do not change

Pattern for 0.25UI, 200Hz@6.144MHz Jit-
ter200Hz025UI48k400Hz1kHz400m

Do not change

Pattern for 0.2UI, 400kHz@6.144MHz Jit-
ter400kHz02UI48k400Hz1kHz400m

Do not change

xxx

3. Click Analyze. Configure the 10UI, 5Hz@6.144MHz, 0.25UI, 200Hz@6.144MHz, and 0.2UI,
400kHz@6.144MHz parameters.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.
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View Analysis for Receiver Performance Jitter Tolerance Test
Click Analyze to view the analysis of the receiver performance jitter tolerance test.
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Configure and Run the Receiver Performance Maximum Input Test
To configure and run the receiver performance maximum input test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 59: Acquisition parameters for the receiver performance maximum input test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Amplitude
Deviation.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for 10UI,
48KHz (6.144MHz)

2 Do not change

xxx

3. Click Analyze. Configure the Amplitude Deviation: Maximum Input (mV) parameter.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.

110 TekExpress HEAC Automated Solution



How To View Analysis for Receiver Performance Maximum Input Test

View Analysis for Receiver Performance Maximum Input Test
Click Analyze to view the analysis of the receiver performance maximum input test.
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Configure and Run the Receiver Performance Minimum Input Test
To configure and run the receiver performance minimum input test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 60: Acquisition parameters for the receiver performance minimum input test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Amplitude
Deviation.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for 10UI,
48KHz (6.144MHz)

2 Do not change

xxx

3. Click Analyze. Configure the Amplitude Deviation: Minimum Input (mV) parameter.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.
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View Analysis for Receiver Performance Minimum Input Test
Click Analyze to view the analysis of the receiver performance minimum input test.

Make Connections for Common Mode Operating DC Voltage Test
You will need the following equipment to perform the common mode Operating DC Voltage receiver test:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Arbitrary waveform generator Tektronix AWG5000 Series, AWG5000B Series, AWG7000 Series,
and AWG7000B Series Arbitrary Waveform Generator

Probe Tektronix P6243 or P6245 for Tektronix DPO70000 Series,
DPO70000B Series, DSA70000 Series, and DSA70000B Series, and
MSO7000 Series Digital and Mixed Oscilloscopes
Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series
Digital Oscilloscopes

HEAC TPA-P adapter Tektronix HEAC-TPA-P
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Resource Model supported
Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx

Connect the equipment as shown in the following diagram:

1. Connect the HEAC-TPA plug board to the HEAC connector on the Source DUT.

2. Connect the CEC or CDC Controller to CEC/CDC Control Port on the HEAC-TPA main board.

3. Connect the Ch1 Analog(+) output from a waveform generator to the HEAC+ SMA connector of the
HEAC-TPA main board and the Ch2 Analog(+) to the HEAC– SMA connector.

4. Set the Impedance Conversion Circuit on the HEAC-TPA main board to 50 Ω:
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See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

5. Connect a single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on the
HEAC-TPA main board, and a second single-ended probe from Ch2 to the HEAC– probe point.

6. Set the HEAC-TPA main board to enable the Source DUT test, and use +5 V power from the DC
Power Supply. Set switch S7 to the right (On position) on the HEAC-TPA main fixture.

NOTE. Do not use +5 V power from the Source DUT.

7. Connect and set the DC Power Supply to supply +5 V to the HEAC-TPA main board.

8. Power on the Source DUT.

9. Activate the ARC (Common mode) transmission on the HEAC Source DUT using the CEC/CDC
controller.

Configure and Run the Common Mode Operating DC Voltage Test
To configure and run the Operating DC Voltage test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the DC Voltage HEAC + Line and the DC
Voltage HEAC – Line in the following table. It is recommended that you do not change these values.

Table 61: Acquisition parameters for the common mode operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV) 200 100, 200, 400
Vertical Position (div) 0 Do not change
Vertical Offset (V) Auto Auto, 2, 4, 6
Horizontal Scale (μSec) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 2500000 1250000, 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.

3. Click Analyze. Configure the following:
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Table 62: Analysis parameters for the common mode operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level 4 2,4, 6
Edge Trigger Slope Positive Positive, Negative
xxx

4. Click Limits. Configure the DC Voltage HEAC + line and DC Voltage HEAC – line values and the
compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

8. If you detect the audio response, click Detected. If you do not detect the audio response, click Not
Detected. The Acquire panel shows the progress and status of the test as it runs.

View Analysis for Common Mode Operating DC Voltage Test
Click Analyze to view the analysis of the Common Mode Operating DC Voltage test.
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View Results for a Common Mode Receiver Test
You can view the common mode receiver test results in the Analyze panel. A table shows the test name,
audio status, measurement details, test result (pass/fail), Compliance Mode, and analysis time. The
application also automatically displays a report in the Report panel once the test is successfully completed.
Save this report as an MHT file using the File > Save As option.

The following screen shows the results for common mode receiver tests.
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Select a Single Mode Receiver Test
In TekExpress, the Select panel allows you to select the receiver tests to configure and run.

1. Launch TekExpress HEAC.

2. Select the device as HEAC-Receiver.

3. Select the test suite as SingleMode-Rx and the version is CTS 1.4.

4. Enter the DUT ID in the field provided.

5. Select a test from the list: Nominal Response, Receiver Performance-Amplitude, Receiver
Performance-Jitter Tolerance, and Operating DC Voltage.

NOTE. By default, all receiver tests are selected. To select a particular test, click Deselect All, and select
the required test from the table.

Make Connections for a Single Mode Receiver Test
You will need the following equipment to perform a single mode receiver test:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Arbitrary waveform generator Tektronix AWG5000 Series, AWG5000B Series, AWG7000 Series,
and AWG7000B Series Arbitrary Waveform Generator

Probe Tektronix P6243 or P6245 for Tektronix DPO70000 Series,
DPO70000B Series, DSA70000 Series, and DSA70000B Series, and
MSO7000 Series Digital and Mixed Oscilloscopes
Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series
Digital Oscilloscopes

HEAC TPA-P adapter Tektronix HEAC-TPA-P
Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC sink or source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx
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Connect the equipment as shown in the following diagram:

1. Connect the HEAC-TPA plug board to the HEAC connector on the Source DUT.

2. Connect the CEC or CDC Controller to the CEC/CDC Control Port on the HEAC-TPA main board.

3. Connect the Ch1 Analog(+) output from a waveform generator to the HEAC+ SMA connector of
the HEAC-TPA main board.

4. Set the Impedance Conversion Circuit on the HEAC-TPA main board to 55 Ω:

See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

5. Connect a single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on
the HEAC-TPA main board.

6. Set the HEAC-TPA main board to use +5 V power from the DC Power Supply and not from the
Source DUT.
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7. Load the waveform data on the arbitrary waveform generator and generate the waveforms.

8. Activate the ARC (Single mode) transmission on the HEAC Sink DUT using the CEC/CDC controller.

Configure and Run a Single Mode Receiver Test
To configure and run a single mode receiver test, select one or more tests and do the following:

1. In the Select panel click Configure.

NOTE. The nominal response test is provided (although not part of the CTS 1.4) for you to test whether
your DUT is working with nominal signal levels. The Compliance Mode is not available for the Nominal
Response test.

2. In the Configure panel, select either Compliance Mode or User Defined Mode. In the User Defined
Mode, you can modify the test parameters but you will no longer be testing against the compliance
standards. In the Compliance Mode, you cannot modify any of the parameters.

Table 63: General parameters for single mode receiver tests
Parameter Description
Signal Source Select the arbitrary waveform generator as the signal

source.
Real Time Scope Select the oscilloscope to which to connect.
DUT High Signal connected to Real Time Scope at Select the oscilloscope channel to which the DUT High

signal is connected.
Test at Vel = 0 V Select whether to include or exclude the test at this voltage.
Test at Vel = 2.5 V Select whether to include or exclude the test at this voltage.
Test at Vel = 5 V Select whether to include or exclude the test at this voltage.
xxx

3. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

4. The single mode receiver tests run at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. For each
voltage level, the application prompts you to verify the audio response from the DUT. If you detect the
audio response, click Detected. If you do not detect the audio response, click Not Detected.

5. Repeat this for different terminal voltage levels and audio patterns of various frequencies
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Configure and Run the Receiver Performance Nominal Response Test
To configure and run the receiver performance nominal response test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern as in the following table. It
is recommended that you do not change these values.

NOTE. The Compliance Mode is not available for the Nominal Response test.

Table 64: Acquisition parameters for the nominal response test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Nominal
Response.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for Nominal Pattern 2 Do not change
xxx

NOTE. The Analyze and Limits tabs have no configurable parameters.

3. Click Comments to enter comments. The comments are shown in the test report.

4. Click Apply to effect the changes, and then click Close.

5. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

6. The single mode receiver tests run at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. For each
voltage level, the application prompts you to verify the audio response from the DUT. If you detect the
audio response, click Detected. If you do not detect the audio response, click Not Detected.

Repeat this for different terminal voltage levels and audio patterns of various frequencies.
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View Analysis for the Receiver Performance Nominal Response Test
Click Analyze to view the analysis of the nominal response test.

Configure and Run the Receiver Performance Jitter Tolerance Test
To configure and run the receiver performance jitter tolerance test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters for Audio Pattern are defined as in the following table. It is
recommended that you do not change these values.

Table 65: Acquisition parameters for the jitter tolerance test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Jitter
Tolerance.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
Pattern for 10UI, 5Hz @ 6.144MHz Jit-

ter5Hz10UI48k400Hz1kHz400mV_c
Do not change
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Table 65: Acquisition parameters for the jitter tolerance test (cont.)

Parameter Compliance mode
Permitted user defined mode
values

Pattern for 0.25UI, 200Hz @
6.144MHz

Jit-
ter200Hz025UI48k400Hz1kHz400m

Do not change

Pattern for 0.2UI, 400kHz @
6.144MHz

Jit-
ter400kHz02UI48k400Hz1kHz400m

Do not change

xxx

3. Click Analyze. Configure the 10UI, 5Hz @ 6.144MHz, Pattern for 0.25UI, 200Hz @ 6.144MHz, and
Pattern for 0.2UI, 400kHz @ 6.144MHz parameters.

Table 66: Analysis parameters for the jitter tolerance test

Parameter Compliance mode
Permitted user defined mode
values

Pattern for 10UI, 5Hz @ 6.144MHz Include Include, Exclude
Pattern for 0.25UI, 200Hz @
6.144MHz

Include Include, Exclude

Pattern for 0.2UI, 400kHz @
6.144MHz

Include Include, Exclude

xxx

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. The single mode receiver tests run at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. For each
voltage level, the application prompts you to verify the audio response from the DUT. If you detect the
audio response, click Detected. If you do not detect the audio response, click Not Detected.

Repeat this for different terminal voltage levels and audio patterns of various frequencies.
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View Analysis for the Receiver Performance Jitter Tolerance Test
Click Analyze to view the analysis of the jitter tolerance test.
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Configure and Run the Receiver Performance Maximum Input Test
To configure and run the receiver performance maximum input test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 67: Acquisition parameters for the receiver performance maximum input test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Amplitude
Deviation.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for 10UI,
48KHz (6.144MHz)

2 Do not change

xxx

3. Click Analyze. Configure the Amplitude Deviation: Maximum Input (mV) parameter.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. The single mode receiver tests run at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. For each
voltage level, the application prompts you to verify the audio response from the DUT. If you detect the
audio response, click Detected. If you do not detect the audio response, click Not Detected.

Repeat this for different terminal voltage levels and audio patterns of various frequencies.
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View Analysis for Receiver Performance Maximum Input Test
Click Analyze to view the analysis of the receiver performance maximum input test.
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Configure and Run the Receiver Performance Minimum Input Test
To configure and run the receiver performance minimum input test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters are defined for the Audio Pattern in the following table. It is
recommended that you do not change these values.

Table 68: Acquisition parameters for the receiver performance minimum input test

Parameter Compliance mode
Permitted user defined mode
values

AWG File Name C:\HEAC Patterns\Audio\Amplitude
Deviation.awg

Do not change

AWG Index for NULL Pattern 1 Do not change
AWG Index for 10UI,
48KHz (6.144MHz)

2 Do not change

xxx

3. Click Analyze. Configure the Amplitude Deviation: Minimum Input (mV) parameter.

NOTE. The Limits tab has no configurable parameters.

4. Click Comments to enter comments. The comments are shown in the test report.

5. Click Apply to effect the changes, and then click Close.

6. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

7. The single mode receiver tests run at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. For each
voltage level, the application prompts you to verify the audio response from the DUT. If you detect the
audio response, click Detected. If you do not detect the audio response, click Not Detected.

Repeat this for different terminal voltage levels and audio patterns of various frequencies.
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View Analysis for Receiver Performance Minimum Input Test
Click Analyze to view the analysis of the receiver performance minimum input test.

Make Connections for the Single Mode Operating DC Voltage Test
You will need the following equipment to perform a single mode receiver test:

Resource Model supported
Real-time oscilloscope Tektronix DPO7000 Series, DPO70000 Series, DPO70000B Series,

DSA70000 Series, DSA70000B Series, and MSO70000 Series Digital
and Mixed Signal Oscilloscopes

Arbitrary waveform generator Tektronix AWG5000 Series, AWG5000B Series, AWG7000 Series,
and AWG7000B Series Arbitrary Waveform Generators

Probe Tektronix P6243 or P6245 for Tektronix DPO70000 Series,
DPO70000B Series, DSA70000 Series, and DSA70000B Series, and
MSO7000 Series Digital and Mixed Oscilloscopes
Tektronix P6243, P6245, or TAP1500 for Tektronix DPO7000 Series
Digital Oscilloscopes

HEAC TPA-P adapter Tektronix HEAC-TPA-P
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Resource Model supported
Test fixture TF-HEAC-TPA-P (A/C) or TF-HEAC-TPA-KIT, TF-HDMID-TPA-KIT
DUT An HEAC source device
SMA Cables Tektronix part number 174-1428-00 (1.5 meter)

Tektronix part number 174-1341-00 (1 meter)
HDMI Cable HDMI cable with HEAC capability
xxx

Connect the equipment as shown in the following diagram:

1. Connect the HEAC-TPA plug board to the HEAC connector on the Source DUT.

2. Connect the CEC or CDC Controller to CEC/CDC Control Port on the HEAC-TPA main board.

3. Connect the Ch1 Analog(+) output from a waveform generator to the HEAC+ SMA connector of
the HEAC-TPA main board.

4. Set the Coupling and Impedance Conversion Circuit on the HEAC-TPA main board to 55 Ω:
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See Set Up the Jumpers on the HEAC-TPA-MAIN Fixture (see page 24) and Set Up the Switches on
the HEAC-TPA-MAIN Fixture (see page 23)

5. Connect a single-ended probe from Ch1 of the digital oscilloscope to the HEAC+ probe point on
the HEAC-TPA main board.

6. Set the HEAC-TPA main board to use +5 V power from the DC Power Supply. Set switch S7 to the
right (On position) on the HEAC-TPA main fixture.

NOTE. Do not use +5 V power from the Source DUT.

7. Connect and set the DC Power Supply to supply +5 V to the HEAC-TPA main board.

8. Power on the Source DUT.

9. Activate the ARC (Single mode) transmission on the HEAC Source DUT using the CEC/CDC
controller.

10. Load the nominal audio waveform data on the arbitrary waveform generator and generate the
waveform.

Configure and Run the Single Mode Operating DC Voltage test
To configure and run the Operating DC Voltage test, do the following:

1. In the Select panel, highlight the test and click Configure.

2. In the User Defined Mode, the parameters for HEAC DC Voltage are defined in the following table. It
is recommended that you do not change these values.

Table 69: Acquisition parameters for the single mode operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Vertical Scale (mV-Div) 200 100, 200, 400
Vertical Position (div) 0 Do not change
Vertical Offset (V) Auto Auto, 2, 4, 6
Horizontal Scale (μSec) 10 5, 10, 20
Horizontal Position (%) 50 50, 70, 90
Record Length 2500000 1250000, 2500000, 5000000
xxx

NOTE. In the User Defined Mode, during test execution the specified horizontal acquisition parameters
(such as horizontal scale and record length) might not be applied exactly as specified in the configuration
panel. Depending upon the oscilloscope model, the nearest possible value is applied.
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3. Click Analyze.

Table 70: Analysis parameters for the single mode operating DC voltage test

Parameter Compliance mode
Permitted user defined mode
values

Edge Trigger Level 4 2, 4, 6
Edge Trigger Slope Positive Positive, Negative
xxx

4. Click Limits. Configure the DC Voltage HEAC + line and DC Voltage HEAC –line values and the
compare string.

5. Click Comments to enter comments. The comments are shown in the test report.

6. Click Apply to effect the changes, and then click Close.

7. In the Select panel, click Run to start the test. The Acquire panel shows the progress and status
of the test as it runs.

8. The test runs at three terminal voltage levels (Vel): 0 V, 2.5 V, and 5 V. Adjust the voltage and click
OK to proceed with the test.
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View Analysis for the Single Mode Operating DC Voltage Test
Click Analyze to view the analysis of the Single Mode Operating DC Voltage test.
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View Results for Single Mode Receiver Tests
You can view the single mode receiver test results in the Analyze panel. A table shows the test name, audio
status, measurement details, test result (pass/fail), Compliance Mode, and analysis time. The application
also automatically displays a report in the Report panel once the test is successfully completed. Save this
report as an MHT file using the File > Save As option.

The following screen shows the results for single mode receiver tests.
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About the Programmatic Interface
The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of TekExpress application
running on a local or a remote PC. Following operations can be performed using the programmatic
interface exposed by TekExpress:

(see page 146)Query DUT ID

(see page 147)Set DUT ID

(see page 148)SaveSession

(see page 150)RecallSession

(see page 151)Run the TekExpress execution

(see page 152)Stop the TekExpress execution

(see page 153)Query execution status

(see page 154)Transfer result files

(see page 156)Check the application status

For simplifying the descriptions, the following terminologies are used in this section:

TekExpress Client: A High level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.
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Click the following links to get details on them:

What does one need to have to develop TekExpress Client?

While developing TekExpress Client one needs to use the TekExpressClient.dll. The client can be a VB
.Net, C# .Net, TestStand or web application. The examples for interfaces in each of these applications
are in Samples folder.

References required
TekExpressClient.dll has internal reference to IIdlglib.dll and IRemoteInterface.dll IIdlglib.dll has a
reference to TekDotNetLib.dll. IRemoteInterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the server and the client.
IIdlglib.dll provides the methods to generate and direct the secondary dialog messages at the client-end.

NOTE. The end-user client application does not need any reference to above mentioned DLL files. It is
essential to have these DLLs (IRemoteInterface.dll, IIdlglib.dll and TekDotNetLib.dll) in same folder
location as that of TekExpressClient.dll.

What steps does a client need to follow?

The following are the steps that a client needs to follow to use the TekExpressClient.dll to programmatically
control the server:

A client UI has to be developed to access the interfaces exposed through the server. This client needs to
load TekExpressClient.dll to access the interfaces. Once the TekExpressClient.dll is loaded, the
client UI can call the specific functions to run the operations requested by the client. Once the client is up
and running, it has to do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is running to connect to
the server.

2. The client needs to lock the server application to avoid conflict with any other Client that may try to
control the server simultaneously. “Lock” would also disable all user controls on server so that server
state cannot be changed by manual operation.

3. If any other client tries to access a server which is locked, it will get a notification that the server
is locked by another client.

4. When the client has connected to and locked the server, the client can access any of the programmatic
controls to run the remote automations.
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5. Once the client operations are completed, the server needs to be “unlocked” by the client.

Server and Client Proxy Objects

Remote Proxy Object
The server exposes a remote object to let the remote client access and perform the server side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof (TekExpressRe-

moteInterface), “TekExpress Remote interface”, WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,

//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),

URL.ToString());
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Client Proxy Object
Client exposes a proxy object to receive certain information.

For example,

//Register the client proxy object

WellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredWell-

KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface),

“Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:

1. To get the secondary dialog messages from the server.

2. To get the file transfer commands from the server while transferring the report.

Click here to see examples.

clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);

clientObject.clientIntf.TransferBytes(buffer, read, fileLength);
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To know more on the topics below, click the links.

Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.

Connect()

Connect(string ipAddress, out string clientID)
This method connects the client to the server. The client provides the ip address of the server to connect to
the server. The server provides a unique clientId when the client is connected to it.

Parameters

Name Type Direction Description
ipAdress string IN The ip address of the server to which the client is

trying to connect to. This is required to establish
the connection between the server and the client.

clientid String OUT Identifier of the client that is connected to the
server.
clientId = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

xxx
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Return Value
Value that suggests the status if the connection was established or an error occured. The return value is an
object that can be a boolean value, returning true or a string, returning the error message.

Example
try {

IPAddress[] hostIPAddr = Dns.GetHostAddresses(Dns.GetHostName());

// Connect to the remoter Server

remoteObject.Connect(hostIPAddress, clientInterface, out clientID);

return true;

}

catch (Exception error)

{

return error;

}

Comments
The server has to be active and running for the client to connect to the server. Any number of clients can
be connected to the server at a time. Each client will get a unique id.

Disconnect()

Disconnect(string id)
This method disconnects the client from the server it is connected to.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.
xxx

Return Value
Integer value that suggests the status of the operation after it has been performed.

1 – Success
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–1 – Failure

Example
try

{

string returnVal = UnlockServer (clientId);

remoteObject.Disconnect (clientId);

return 1;

}

Comments
When the client is disconnected, it is unlocked from the server and then disconnected. The id is reused.
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LockSession()

LockSession(string id)
This method locks the server. The client has to call this method before running any of the remote
automations. The server can be locked by only one client.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.
xxx

Return Value
String value that suggests the status of the operation after it has been performed.

Example
if (locked)

return “Session has already been locked!”;

returnVal = remoteObject.LockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = true;

return “Session Locked...”;

}

Comments
When the client tries to lock a server that is locked by another client, the client gets a notification that the
server is already locked and it has to wait until the server is unlocked.

If the client locks the server and is idle for a certain amount of time then the server is unlocked
automatically from that client.
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UnlockSession()

UnlockSession(string id)
This method unlocks the server from the client. The client id of the client to be unlocked has to be provided.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.UnlockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = false;

return “Session Un-Locked...”;

}

Comments
When the client is disconnected, it is automatically unlocked.
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SetTimeOut()

SetTimeOut (string id, string time)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

time string IN The time in seconds which
refers to the timeout period.

xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

if (locked == true)

{

tempTime = Int32.Parse(time);

}

if (tempTime < 0)

return “Enter a valid Timeout Period”;

else

{

timeout = tempTime;

return “Timeout Period Changed”;

}

}
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Comments
The time parameter gives the timeout period, that is the time the client is allowed to be locked and idle.
After the timeout period if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to provide a valid timeout
period.

GetTimeOut()

GetTimeOut (string id)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

ResetTimer();

return timeOut.ToString();

}

Comments
The timeout period is a positive integer.
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GetDutId()

GetDutId(string id, string dutId)
This method gives the DUT id of the current set-up.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
dutId string OUT The DUT id of the set-up.
xxx

Return Value
String that gives the timeout period (in seconds) of the client.

Example
returnVal = remoteObject.GetDutId(clientId, out id);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

return id;

}

else

return CommandFailed(returnVal);

Comments
The dutId is an OUT parameter whose value is set after the server processes the request.
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ChangeDutId()

ChangeDutId(string id, string dutName)
This method changes the DUT id of the set-up. The client has to provide a valid DUT id.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
dutName string IN The new DUT id of the setup.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
If (dut Id.Length <=0 && locked == true)

return “Enter a valid DUT-ID”;

returnVal = remoteObject.ChangeDutId(clientId, dutId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “DUT Id Changed...”;

else

return CommandFailed(returnVal);

Comments
If the dutName parameter is null, the client is prompted to provide a valid DUT id.
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SaveSession()

SaveSession(string id, string name)
Saves the current session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being saved.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different name.
Instead SaveSessionAs can be used.
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SaveSessionAs()

SaveSessionAs(string id, string name)
Saves the current session in a different name every time this method is called. The name of the session is
provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being saved.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSessionAs(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The same session is saved under different names using this method. The name parameter cannot be empty.
If it is empty, the client is prompted to provide a valid name.
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RecallSession()

RecallSession(string id, string name)
Recalls a saved session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being recalled.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.RecallSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Recalled...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.
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Run()

Run(string id)
Runs the setup. Once the server is set up and is configured, it can be run remotely using this function.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Run(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Run started...”;

else

return CommandFailed(returnVal);

Comments
When the run is performed the status of the run is updated periodically using a timer.
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Stop()

Stop(string id)
Stops the run operation.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Stop(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Stopped...”;

else

return CommandFailed(returnVal);

Comments
When the session is stopped the client is prompted to stop the session and is stopped at the consent.
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QueryStatus()

QueryStatus(string id, out string[] status)
This method gives the status of the run as messages. The status messages are generated once the run
is started.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
status string array OUT The list of status messages generated

during run.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.QueryStatus(clientId, out statusMessages);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Status updated...”;

else

return CommandFailed(returnVal);

Comments
The status messages are updated periodically after the run begins. The status is an out parameter which is
set when the server processes the request.
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TransferReport()

TransferReport(string id, string filePath)
This method transfers the report generated after the run. The report contains the summary of the run. The
client has to provide the location where the report is to be saved at the client-end.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
filePath string IN The location where the report has to be

saved in the client.
xxx

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.TransferReport(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Transferred...”;

else

return CommandFailed(returnVal);

Comments
If the client does not provide the location to save the report, the report is saved at C:\ProgramFiles.
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CheckSessionSaved()

CheckSessionSaved(string id, out bool saved)
This function is called when a check is to be made to know if the current session is saved.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
saved bool OUT Boolean which represents if the current

session is saved.
xxx

Return Value
Void

Example
if (clientId == ClientID)

{

returnVal = remoteObject.IsSessionSaved(id,out saved);

}

Comments
The saved parameter gives the boolean value suggesting if the current session is saved or not. This is used
as a check in SaveSession() and SaveSessionAs() Functions.
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ApplicationStatus()

ApplicationStatus(string id)
This method gets the status (ready, running, paused) of the server application.

Parameters

Name Type Direction Description
Id string IN Identifier of the client that is performing

the remote function.
xxx

Return Value
String value that gives the status of the server application.

Example
returnVal = remoteObject.ApplicationStatus(clientId);

return returnVal;

Comments
The application can be in one of the following states at a given time:

Ready – Test configured and ready to start

Running – Test running

Paused – Test paused
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ErrorCodes
The return value of the remote automations at the server-end is OP_STATUS which is changed to a string
value depending on its code and returned to the client.

The values of OP_STATUS are as follows:

Value Code Description
FAIL −1 The operation failed.
SUCCESS 1 The operation succeeded.
NOTFOUND 2 Server not found
LOCKED 3 The server is locked by another client, so operation cannot

be performed.
UNLOCK 4 The server is not locked. Lock the server before performing

the operation.
NULL 0 Nothing
xxx

Example
The following is an example for NI TestStand Client available in the path, C:\Program
Files\Tektronix\TekExpress\Examples\Programmatic Interface\TestStand
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Instrument Connectivity
If the instrument(s) are displayed in TekVISA Instrument Manager but not in the TekExpress Instrument
Bench, check the following:

Only those instruments that respond to *idn? and *opt? queries successfully, are displayed in
Instrument Bench.

Ensure that VXI-11 Server is running on the instruments.

If Instrument initialization fails during test sequence execution, do the following:

It is observed that GPIB communication with instrument over TekVISA layer is not initialized if in
TekVISA Instrument manager the search criteria is turned-off even if valid instrument is connected in the
network. It is necessary to turn ON the respective search criteria by opening the TekVISA Instrument
manager.

TestStand Run Time Engine Installation
Managing multiple versions of TestStand installed on the system.

TekExpress installs TestStand version 3.5 runtime engine. If you have versions other than 3.5, while
working with TekExpress, ensure that the version shipped with TekExpress is active. Do so by clicking
Start > Programs > National Instruments > TestStand 3.5 > TestStand Version Selector.
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Shortcut Keys
The following table lists the application shortcut keys:

Table 71: Keyboard shortcut keys
Menu Shortcut keys
File Alt + F
New Session Ctrl + N
Open Session... Ctrl + O
Save Session... Ctrl + S
Save Report As... Ctrl + R
Print Preview Report Ctrl + V
Print Report... Ctrl + P
Exit Ctrl + X
View Alt + V
Log File Ctrl + L
Tools Alt + T
Instrument Bench... Ctrl + I
Help Alt + H
xxx
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